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Guinea Pig 54 - 50,000 Chicken 125 - 2,000
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2.7 FuazuaINNLUNY [7]
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https://th.wikipedia.org/wiki/%E0%B8%AA%E0%B8%B5%E0%B8%AA%E0%B9%89%E0%B8%A1
https://th.wikipedia.org/wiki/%E0%B8%AA%E0%B8%B5%E0%B9%80%E0%B8%AB%E0%B8%A5%E0%B8%B7%E0%B8%AD%E0%B8%87
https://th.wikipedia.org/wiki/%E0%B8%AA%E0%B8%B5%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%A7
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https://th.wikipedia.org/wiki/%E0%B8%AA%E0%B8%B5%E0%B8%A1%E0%B9%88%E0%B8%A7%E0%B8%87
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2.7.1 dUATIBVDINAS [8]
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2.8 1830 Arduino UNO R3 [9]

R < s s A 1y
Arduino WuveialulnsnouInsmeinszga AVR NTUNSHAMUIUD Open Source
A A a 9 g’/ 9 IJa o A A
ﬂ@ﬂﬂWiLﬂﬂLWﬂm@yﬁﬂﬂﬂWn Hardware 101 Software Glflf‘]ﬂ"l ATmega328 TUNAIND 16 MHz
] o =) J 4 .
WUIEANI N aY 32 KB 15N 2 KB IﬂfJLﬂJEJuIﬂiLLﬂi%J‘]JH‘M@WT]LL’Ji Arduino IDE ttag

Tsunsurunesa USB

[11]

M3199 2.3 AMENUAYDS Arduino UNO R3

hliliﬂiﬂﬁ]ui‘ﬂim%% _____ —TZT_rr;ega\Bé?
uvasee Onaya“ﬂmnwﬁﬁa‘e

Tzt 7-12V

i (1 137) 6-20V

WAINBA /O 14 1 (6 5095 VIOIANAUUY PWM
MOLUIADNDUNS 6

nazud vl DC v 1/O 40 mA

aszua llihesn DC MU 3.3V 50 mA

Flash Memory 32 KB (ATmega328)
SRAM 2 KB (ATmega328)
EEPROM 1 KB (ATmega3238)

Clock Speed 16 MHz


http://en.wikipedia.org/wiki/Arduino
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2.8.1 f%inie Layout ¥1Pin #tazgUn3aiunuesa Arduino Uno R3

3.m0$m ICSP - dwisy USB interface

4wefn /O

124{SPI) MISO
114{SPI) MOSI
104SP1) SS
3nterrupt 1
2-Interrupt 0
0,1-Serial

2.4y Reset

OO® ROMETMNAS
) T 1 v

DIGITAL (Pwn~) F &

1wednUSB |

| 5wefn ICSP : Atmega328

10.MCU : Atmegal6U2

9.9 Power jack 7-12 V 6MCU : Atmega328

-

.

Tnefn /O

U0 2.13 nanadn/§ERouvei05a Arduino Uno R3

1. USBPort: 15dwisudeny Computer 1ot lvian 115105t MCU nazaelnld
fuvesa

2. Reset Button: 15lutfu Reset Tinaifioda1ns i MeU umsaulu
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2.8.2 gaauNiinl#vesa Arduino luniion
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2.8.3 manaalulilsunss Arduine

1.) WaTlysunsy Arduino 7114 111aA11910 hitp://www.arduino.cc/en/Main/Software

519212 Yerouvedli/sdngy Arduino
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3.) 117 Tools -> Board udndenlinsanuuesan e §1915U Arduino UNO R3 liiaen

1959 Arduino UNO

b

sketch_aug21b | Arduino 1.6.5 o | B

File Edit Sketch [Tools| Help
Auto Format Ctrl+T E
Archive Sketch

sketch_aug21| Fix Encoding & Reload u

Serial Monitor Ctrl+Shift+M i
Board: "Arduine Uno! ! Boards Manager...
Port \ Arduino AVR Boards

Programmer: "AVRISP mlkdl" ! Arduine Vin
@ Arduino Uno

Burn Bootloader

] 1 Arduino Duemilanove or Diecimila
Arduinc Mano
Arduinc Mega or Mega 2560
Arduino Mega ADE

Arduing Leonarde
Arduino Micro
Arduino Esplora
Arduing Mini

Arduino Ethernet
Arduine Fie

Arduino BT

LilyPad Arduino USE
LilyPad Arduing
Arduing Pro or Pro Mini
Arduino MG or older
Arduine Robet Contrel

Arduino Robot Motor

Arduino Gemma
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Cardlnfo | Arduino 1.6.5

File Edit Sketch Tools Help

Cardlnfo &

#include «<5PI.h>
#include <5D.h>

S5d2Card card:
SdVolume wvolume;
S5dFile root:

conat int chipSelect = 4;
vold setup()
{
Serial . begin (9600} ;
while (!Serial) {
1
Serial.print (™ W@ylizTTg OO o\ -

310

= 4
2.17 ﬂ1ﬂm&u1ﬂiuﬂinﬁﬁﬂ@iﬂ

Arduing Uno on COM2

m
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5) aoulwaTusunsy 11 Sketch -> Verify/Compile

Cardlnfo | Arduino 16.5 ESEENT
File Edit |Sketch| Tools Help
Verify / Compile Ctrl+R
Upload Ctrl+U
Cardin Upload Using Programmer  Chrl+ Shift+ U
#includ Export compiled Binary Ctrl+Al+5 i
#includ
Show Sketch Folder Ctrl+ K £
Sd2tard Include Library »
JdVolum ] 4
SdFile Add File... nn
const int chipSelect = 4;
void setup()
{
Serial.begin(9600) ;
while (!Serial) {
1
Serial.print ("] Talizing |50 card 10
. e - 19 _— Y- ; :
il ") 3sunalulat s '

Arduing Uno on COM2

1 2.18 1@ennen InaTusunsy
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Cardlnfo | Arduino 165 ENEIT

File Edit Sketch Teools Help

Cardinfo &
#include <SPI.h>
#include <5SD.h>

S3d2Card card;
SdVoclume volume;
3dFile root:

con3t int chipSelect = 4;

vold setup()

{

Serial.begin(9600);
while (!Serial) |

Serial.print "1a’ ializing 5D card.. . ")

of dynamic me

. Maximum iz 2,¢

Arduine Uno on COMM3

d' 9 d‘l 1 g
3ﬂ7]219 Mﬁﬂﬁ%@ﬂ?ﬂﬂWﬂUﬂﬂ??ﬂﬂMiWﬁNWH
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A A 1 J o A
gﬂ‘ﬂ 2.20 MIYBNADVUDIANUADUNUNDT

Y v
8.) 911U 19 11N Tools - Serial Port L@z

1959 Arduino UNO R3 T1lsunsvaziaonlies 1uia)
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Cardlnfo | Arduino 1.6.5

File Edit Sketch [Tools| Help
Auto Format Ctrl+T
Apchive Sketch

Cardinfo § Fik Facoding & Retoad

#include < Serial Monitor Ctrl+ Shift ¥
#include <5D.1

Sd2Card carﬁ; Port: "COM2 (Arduino Uno)"

SdVolume vcllﬁ_
SdFile root; } grammer: "AVRISP rkIl"

e 44
a1 T R L)

void setup()

{

Serial.begin (9600)
while ('Serial) {

}

Serial.print (™\nInitializing 5D card...")r

a|F

ards Manager...

no AVR Boards
ér[ uino Yin

Arduino Uno

Arduino Duemilanove or Diecimila
Arduino Mano

Arduino Mega or Mega 2560
Arduine Mega ADK
Arduino Leonardo

Arduine Micro

Arduino Esplora

Arduino Mini

Arduino Ethernet

Arduino Fio

Arduine BT

LilyPad Arduine USB
LilyPad Arduino

Arduino Pro or Pro Mini
Arduino NG or older
Arduino Robot Control
Arduino Robot Motor

Arduino Gemma

€an

. ) .
1 2.21 @PANOSAVDI Arduino NAoIN T T5UNTY
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9.) TraaTUsunsudhuesa Arduino UNO R3 Tag'l1/# File -> Upload
Cardinfo | Arduino 165 BT

File Edit Sketch Tools Help

Cardinfo §

#include <SPI.h>
#include <5D.h>

5d2Card card; i
SdVolume wvolume; L3
5dFile root;

const int chipSelect = 4;

void setup()

{

) of dynam
Maximum

10.) 1n1511)@ Serial Monitor Y99 Arduino IDE Tae )i Tools -> Serial Monitor

4
Epme 1) ||| )

[
7.(‘
File W€t Sketch [Tool8) Help [T {J
Auto Format Ctrl+T o
Archive Sketch a a(’,
Ty
118 B 1

Flaclude < Ctrl+ Shift=M |~
#include <5D.

Board: "Arduino Uno” » =
gdiCard card: Port: "COM2 (Arduino Una)” » I

SdVolume wvol B
Sdfile root: Programrmer: "AVRISP mkIl" r

const int chij Burn Bootloader

void setup()

{

Serial.begin(9600) ;
while (!'Serial) {

¥

Serial.print(™\nInitializing SD card...");

Arduing U

519 2.23 AA Serial Monitor (NOLAAINA

U



11.) ¥m3i2la Serial Monitor 92 Idton1wasg1

E® COMS3 (Arduino/Genuino Uno)

I
o
0
0
1

Lamp HIGH
Lamp Low

1
Playing song _KIMZA~1.MP
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2.9 U95A Music Shield V2.0 [10]

Music Shield V2.0 911 SeedStudio Vo3afnov8181% Arduino 1R e 131501815 War

(Encode) 11a200a5Hd (Decode) sl 511!3“]] (U1 MP3, WMA, WAV, ACC, MID, OGG Vorbis

a 4 4 1 [l @ 1 o % I P
TaglFFwuos VS1053 1B0uaon1U SPI W3 ounU¥eudel Micro SD Card disuny lldn
Y 1 A s o = =< L=} J 9/3}/ Y o w ' o
Foamsaunie lWdmiuia Feansarfuiina laaue mnvesidaluviianiitennusived

Arduino ez i¥0uTeUUUIA 3.5 mm dmTuaeyarsod) Inald

=i
~
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-
P
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lo 218
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2.9.1 518a108AN5NNUYD9 Music Shield V2.0

indicuor LIS () <ooooooom oooocooon
E3 N i k91411198 768
s P e 3219 DIGITAL
Mutluﬁgfr"on {:( :]II “}\ @ B‘E‘B iBB 5 ; 128 Interface
e B . 5 feig
g (7] g
interface —OB:}» B~ g B N B - 3] go s [ SP Interface

Micro
SD card socket

o]

ANALOG

12848,
Qo OOOOO/

-
iy
=
% 3
+
+
et —
-
+u I'"'NE—"‘?
1 —_
n ]
n

C—i-_'!
o~

;

ite]
10

319 2.26 Advs 939 Music Shield V2.0

1. Multifunction button: U815 FeIaZa 0 NINAY

~ gl 4
2. Play/Pause ind%,tor LED (GREEN): ﬂzwmclu%mzmau.
S,

e oo g ADS ,,
3. Headsets interface: Waﬂiﬂﬁ{mmﬁ“ v30 32 Toviu uazanunsoriunly

< I a =
Lﬂuwam’auw@mﬂuamﬁm

=

4. Micro SD card: P39 SD mumgﬂqﬂﬁ@mmmm%’fﬂu 2GB

5. U2: 1o “ty,mumg?mﬂ VS1053B IC, Ogg Vorbis / MP3 / AAC/ WMA /FLAC
/ MIDI

6. U3, U7: 74VHC125 IC, Quad Buffer.

9 s an a 4
7. 128: mmmww%mmmaauwﬁ REN

8. ISP interface: dmSumsthwesa SPI e l¥nunaasimsiyga Mega
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195A Music Shield V2.0 az1¥vuniloufiy Arduino 61931
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D8 — @ugIUILUS U

L4 ﬂl1ﬁ1%ﬁ']ﬁ%ﬂﬂ1ﬁ SPI ﬂ]i!%@lﬂfiﬂ:
D10 — SPI Chip Select
D11 - SPI MOSI
D12 — SPI MISO

D13 - SPI SCK

o ¥y VS1053 Interface:
A0 -31Fav09 VSTD53:
9 9
Al- "ll@iJ”aGIENGUEN VS4053;
A Y
A2 - La@ﬂ“ll@gﬁ"llﬂﬁ VS1053;

A3 - ¥1aonuod VS1053;
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#include <SD.h>
#include <SPI.h>
#include <arduino.h>
#include "MusicPlayer.h"
MusicPlayer myplayer;

void setup()

{
Serial.begin(9600);
myplayer.begin();
myplayer.scanAndPlayAll();

}
void loop(
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2.10 PIR Motion Sensor [11]

4 o § o @ 1
PIR ( Passive Infrared Receiver) A99Un3ains199UAaUSId Infrared 910 IRQHIY
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2.10.1 M3IMNUVYDS PIR Motion
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2.10.2 @3u152nouva1 PIR Motion Sensor
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2. au1l52NoUKNIII95 PIR Motion Sensor
* Delay Time Adjust
1#15umIntanani19u windsulann sz daeaaiue 1 1Buu Wiesainms
o q ¥ v A w A M v 7 < v Y A v
a9 i ldwaunuiufinuladieasnniuny ez Idanuemaeanaiiv 1 A9l nanma
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I3uegnun1515D Delay Time Adjust 1HonuANAIATIILBNATT MInATIVIL liwoNE
I [ o
Taauzilu 0 uaviinduee azdmeanues 119
* Sensitivity Adjust
1515 uam' 1 nazszez lunmsnsway
* Retrigger Setting Jumper
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. . = 3 a A [l a o I
2). L: Single Trigger 1318949 10 uaodn 0 esgluaniizilnd wazodnailu

d' a 2 U 1 1 d'i d' [ 4' 9
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Ny 738'@‘&‘34 “+Power
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H: Repeat Trigger—=
L: Single Trigger— |&

Sensitivity  Time Delay
Adjust Adjust

3109 2.33 naasaIu32NBULMIIIS PIR Motion Sensor
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2.10.4 M31BoNAD PIR Motion Sensor ALUUD5A Arduino UNO R3
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g‘ﬂ‘ﬁ 2.35 HAAINTIYOUAD PIR Motion Sensor ﬁl"UU’O‘}'ﬂ Arduino UNO R3

2.11 5108l (Relay) [12]
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2.11.1 @aulszneumely Relay
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2.11.2 35M3t¥eunev Relay 1UUB3A Arduino UNO R3
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2.12 ‘Uﬂ%ﬂ SON-169 Power Amplifier [13]

t4

. & Ao g (4 a4 A 9 A A A& da g
Amplifier 1(Juginsalnvrnnn/asurssmununevesnauass sanaeidluns
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o Y A v = 9y A Y A A 1
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. . 9 A o 1) d'dy =y 1 .
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=
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11 2.41 UeiA SON-169 Power Amplifier
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Gain Y09IAT09UE101TE9 (Audio Amplifier) d2ulngegninuaalonssau T
(Voltage) F9A1AIUAIUN UV (Input Impedance) Y93 Amplifier ﬁﬂgﬂﬁWﬂuﬂiﬁ}g\iﬂ’h
9 1w 9 Y a 9y
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[

A9 W1asdalaenall Ao 9aNMave18anaInT N8 (Half power bandwidth) H39%24

9

AUDN —3 dB

2.12.2 S1eazPeAvIVDSA SON-169 Power Amplifier
1. UUIR: 16.5 B3, x 13.0 ). x 4.5 G,

2. sziam: wseady Mp3

3. WARNUBUWA: 300W

4. nszua llvieen: Tou 300w

5.au 12 16dB

6. OAIAIUTUUADITEITUA I 90 dB

g 9

9

7. 935150191 HHD: 85%
8. usaau lihduna: 12V

9 o 4
9. ANUATUMIUYDIAT TN: 4-8 ToNY



42

2.13 Solar cell [14]

d a d I A a o ad A Ja Y 2 @ o
aanaee1ing (Solar Cell) 11 udseanindiannsotindnadiennarsnadni

. A Yo a ¢ A % a < A
(Semiconductor) 1/0 @5 Ua991AA190 NS T oA N asa I saduaIoInadazlasy

[ I [ 1 Y] { a
waanuuaudunadsau Iwinszuaas e (Direct Current : DC) Do Wa11u Wi AN
¢ a 2 g o o & L g o A

e nadil \WUnadInunaunusianila (Renewable Energy) Huilundsnuiazonn

waz laawanigla q Inuaanedenluvas 14y

Load

( = Sunlight

A
F nly NTre | paype

1F‘~ - . 'I Silicon ‘ Silicon
\ PN-Junction
¢ WY
%, )
)On _ -*a%
91aginalulad
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2.14.1 MIMNUVBUAIVIAILANNIIGD

IATEIALANNT

funefimef WannTzuanay

wlsasad 2
il

-
WLAART

510 244 M3MUVEAATEIAIVRNMITIIT

A P ! ' s s w A A o
RIDNIAIUANNITUITY %mmzwml,mﬂ%mimaa NULUALAD T meeﬂmm”lﬂ%

! [ A 1 @ Y 1 @ d':: 1A ?_, 9 A
Tagvzgamsaau I lunuames haglusgaula degluszaundininnagld insesniuau
4 o o A . A (Y
msmseaziinisdanlvanoonamsz WY TaeN Ui (Load disconnect) tWofoanun1snate
A A = o 9 A A <3 é‘ U ' ] [
Uszguasuamesnunmu i) naze 19 @iwlan a5 @015 daulngazainus s

v < N\l ¥ A @ 24
ﬂaﬂjﬁaﬂqﬂﬂﬂigu'lm 11.5 I'Jﬁ‘ﬂ ATNI LI NITESUUN 12 I'Jacﬂ u’f]ﬂi]’lﬂu!ﬂi@ﬂﬂ')ﬂﬂﬂﬂ’li

v ' Y
1 [ = (%

s I ' ° ' 9 A A 2 X ~
Glﬂifi]ﬂﬂgﬁi’)ﬂ'lﬁﬂ']QTuGlJﬂ\iIﬁﬁﬂGlWiJ (Load reconnect) DULUANDTUAULTIAUNNUUYUAIUNA

9
(%

1 1 H J o 9 % J a3
14 @y avzaadn 12.6 Tdasl dmsuusaauszuu 12 Taimiludu

wAa v 3d) < J
2.14.2 Qmﬁﬂﬂﬂm@ﬁi“ﬂa']i‘“]i%!ﬂ@ﬁ

¢ 2 Hdq ¥ g A Aq vq ¥ v A
1. G])"liﬂhlv\llaﬂ\ul,ll@l@]ﬂiiﬁlﬁﬂ@]a@ﬂma’llwﬂﬂu@ill!‘ﬂ@]lﬁ]ﬂiﬁlwcl"]f\ﬂuclﬂﬂ'lju']qu@

1" J 4 4 [ 4 a
. T“Ifﬁ”ISﬁlﬂi‘ﬂL%’t’)iﬁnﬂiﬂﬂi’)\‘]ﬂuﬂﬁ%ﬁ‘l’lﬂigL!ﬁlﬂull@g])

N

 teatumsdaminnszua ldunpuldnnuuanes

(98

 teatunszua Iihonuuaees lnadeunau ludwme Taarsias lunainaiedu

N

_tleatumslornes Ivan

W

 HoaruMIan1993

o)

 Hosnunszualvadoundy

~

9
8. foanumsaenavinlaslalon

v
=

9. doanuiien1dludqlildnszua lfauuane

a

&
10. ﬁmwmwqumwnu

R



2.15 Matlab [16]

R2014a

R2014a (8.3.0.532)
64-bit (win64)

February 11, 2014
License Number;

MATLAB

Copyright 1984-2014, The Mat Works, Inc, Protectad by U.S. anc
. See www.mathwork- com/pa- wnts. MATLAB and Simulir

wzdemarks of The MathWorks Inc. Se- www.mathworks.comftr.

<" of addibonal trademarks ( ther prod_c or brand names may

=:istered trademarks of th - e5; ctive ' ders.

e) MathWorks

5110539 Matlab
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MATLAB (Matrix Labotatory) 41 @15 lunissiuianaznsveu Ty sunsy

% { & 1 @ [ a Y o
I‘]Jiuﬂillﬁﬁﬂ ﬁflﬂ’ﬂll’d1llﬁﬂﬂiﬂﬂﬂquﬁﬂlm mﬁwmmaaﬂm'ﬁu NITAITINLUVINADIN
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S
processing 118 wavelet 133 w?gﬁlﬁmwﬁﬁ&ab "lﬂﬂizqﬂm%’qm"lﬁ’ﬁmammw%q
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2ale (Image and Video Processing) & U1 AU A U (Control System) N 17 GG ERT U

o 4 . o a
(Instruments and Control) N1TATUIUNIUATHIAT1 AT (Economic) NITAIUIUNITIING

4 v Aa 4 a 2’1 {
(Biology) tlazduq Minimenmaasuazisnsnatediuaunslumsanyinazgaa1unssui

1% Matlab Tun13suIuFId 1Y
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L) 3 1 4 S { 1Ta ]
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B Figure 3 — [m] X
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MANUIN U

Jaallsunsy Arduino

#include <MusicPlayer.h>
#include <pins_config.h>
#include <vs10xx.h>
#include <SD.h>

#include <SPIL.h>
#include <arduino.h>
#define rxpin

#define txpin
MusicPlayer myplayer;
myplayer

const int myplayerPin = 13;

const int inputPin = 4;

const int inputPin2 = 5;

const int inputPin3 = 6;

int Lampl = 7;

void setup() {

Serial.begin(9600);

pinMode(myplayerPin, OUTPUT);

/181484 S ogluuesa Music Shield
/rad ldannniaa

/ra8e Inldfeglugnmuns vsioxx
/181484 S0y SD Card
/81994 1M 910 SPI

81994 Idnnuesa Arduino
/MYUAVT X

//MAUAVT tx

/a1 fuesa Music Shield 50

o Y 7 . . A 1
mviualdiuese Music Shield 1000 Ing

1591 13
° Y . A '
Hmviuald PIR Motion Sensor [¥9U#0
Taelan 4
o Y . A '
//mviualy PIR Motion Sensor [¥9U#0
Taglda s
/iviua’ly PIR Motion Sensor 1501619
Tagld1 6

yiviualy LED youas Tagldan 7

//mmﬁs’ﬂumsﬁami 9600 baud

o 9y . . I o
/inualivT Music Shield 154 101890



pinMode(inputPin, INPUT);

pinMode(inputPin2, INPUT);

pinMode(inputPin3, INPUT);

myplayer.digitalControlEnable();

myplayer.begin();

pinMode(Lamp1, OUTPUT)

myplayer.setPlayMode(PM_REPEAT LIST);

myplayer.scanAndPlayAll();

}

void loop() {

digitalWrite (inputPin, LOW);

digital Write(inputPin2, LOW);

digitalWrite(inputPin3, LOW); );

delay(50);

int val = digitalRead(inputPin);

static boolean flag_on = 0;
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o Y . o A I
//mwm“lw PIR Motion Sensor 191 1 1
DUNA
o Y . o A I
//ﬂWi'Llﬂglﬁ PIR Motion Sensor 191 2 1l
DUNY
o v A <
/mmualil PIR Motion Sensor @99 3 11/u
DUNY
9 4 . .
/70NN 191U VD3A Music Shield
9y aa
A183LUVAINDA
A 9
/A NAY myplayer
o Y I 4
/imvualvu LED 3y e1dwa
1 = k) ' g = a
/A FeR28 AU UToUAY

Y
/A TININUA

//ﬁWﬁuﬂslﬁ PIR Motion Sensor Sﬁ”J‘ﬁl l'liJ'
ATV

o Y . v A [}

i1viua’ld PIR Motion Sensor @2 13
A3799U301

[ Y . v A [}

/iviua’ld PIR Motion Sensor @23 13

737990309

yimua i val dluanduldan

PIR MotionSensor 739 1
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int val2 = digitalRead(inputPin2); Jimuali val ifuansulden
PIR Motion Sensor #971 2
int val3 = digitalRead(inputPin3); Jimuali vas Wuansulden
PIR MotionSensor #311 3
. Y 1 Aoy A A
if(val == HIGH]||val2 == HIGH]||val3 == HIGH) /a1m1n 5018910 val 1130 val2 1150

val3 19110 U High La@A911ATIINUNISG

waou'lng
{
digitalWrite(myplayerPin, HIGH): /imvualinveauo3a Music Shield
‘JuHigh
delay(50);
myplayer.play(); //ﬁb am31¥ue3a Music Shield 1au
BN
if(flag_on) {player.opPlay();flag_on =0;}
delay(50);
digital Write(myplayerPin, LOW); // Mvualiuesa Music Shield 31
1A Low AongAaudes
delay(50);
digitalWrite(Lamp 1, HIGH); sivualiaives LED 15w High
delay(300);
digital Write(Lamp 1, LOW); Jvualiaives LED 1l Low
delay(300);
§

else{ player.opPause(); flag on = 1;
§
¥



Jaalisunsyu MATLAB

clear all; clc;
[y,Fs] = audioread([......... ].mp3");

data_size=size(y(:,1),1);

x_corel=l:data_size;

y_first=transpose(y(:,1));

figure()
plot(x_corel,y first)
xlabel('sample’)
ylabel('amplitude')
grid

NFFT = 2"nextpow2(data_size);

Y = fft(y_first, NFFT)/data_size;
f=Fs/2*linspace(0,1,NFFT/2#1);

figure;

plot(f,2*abs(Y(1:NFFT/2+1)))
title('Single-Sided Amplitude Spectrum of y(t)")
xlabel('Frequency (Hz)")

ylabel('Y()[)

Y _dB=10*log10(2*abs(Y(1:NFFT/2+1)));
figure()

plot(f,Y_dB)

xlabel('Frequency (Hz)")

ylabel('Intensity (dB)")

v
/audoyamssuns
' 14 { A
semdoyaninlididosne (.. )
9 J Yo I
/mvuadeyavesn y oz lamasuiilu
a o o
NI ngULIa [S1uaudoya x 1]
/adramvaunuuny x musuaudeya
a 4 4 S
Tuun3nd y e 15 lumsnseans
@ a 4 I
sdueumning y Widluvuna
o 9
[1 x T1uv0ya]
/edanseugll
<
Jnaenns N @ x , N y)
A
/DU x
A
H¥oUN y
MAiadueng
/1A Next power Y93 Fast Fourier
Transform
//iM Fast Fourier Transform

o I {
St 1 Tamunud

Jmiinaon
/ons v
//Aount x
/Feuny y

//%1 Fast Fourier Transform

//FBUAU X

/founi y
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